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VISUALIZATION IN GEODICT 2024 

INTRODUCTION 

For visualization, GeoDict distinguishes two concepts: structure (or geometry-related 
data) and result fields (or property-related data).  

◼ Structures can be created as output data from GeoDict's generation modules 
(ending in Geo) or imported with GeoDict's import modules (beginning with 
Import). They are input data for GeoDict's material properties prediction 

modules (ending in Dict).  

◼ Result fields are the output data of GeoDict's material property prediction 

modules. Using result fields GeoDict provides great visualization options for the 
simulation results.  

REQUIREMENTS 

GeoDict uses OpenGL to visualize structures and results in 3D. GeoDict is compatible 
with the oldest possible OpenGL version (1.1), which is guaranteed to be available in 
any Windows system. However, some visualization features require more advanced 

OpenGL versions: 

◼ rendering animated streamlets requires OpenGL 2.0 

◼ rendering spherical particles requires OpenGL 3.3. If this version is not 
available, a much slower fallback solution is used.  

On Windows remote desktop sessions, usage of hardware acceleration is only possible 

with NVidia Quadro cards of the series x000. This limitation can be avoided if Windows 
Remote Desktop Acceleration of NVidia DesignWorks is used. 

If no hardware acceleration is present, Mesa software rendering is used automatically. 
The necessary Mesa libraries are included in the GeoDict installation folder.  

For Linux remote sessions, we recommend using VirtualGL and TurboVNC for remote 

3D rendering. The installation of these tools is described in the High Performance 
Computing handbook of the User Guide.   

It is also possible to connect from a Linux terminal to a Linux server using ssh -X, 
without the installation of VirtualGL and TurboVNC. In this case, visualization in 3D is 
only possible when Indirect GLX is enabled on the Linux terminal (it is not necessary 

to enable this on the Linux server that runs GeoDict, but it must be enabled on the 
terminal that runs the X11 server). By default, this option is disabled in many cases. 

The status of this option can be checked with  

grep -i "Indirect" /var/log/Xorg.0.log.  

Output is, for example: 

[1344382.166] (II) Indirect GLX disabled.     

To enable this option is not straightforward, works differently on different Linux 

systems or different graphic cards, and often requires a system administrator to 
change the config files of the system. For example, on Ubuntu 14.04 LTS it is 

https://developer.nvidia.com/designworks
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=HighPerformComp&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=HighPerformComp&release=2024
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necessary to include the option +iglx in the file /usr/share/lightdm/lightdm.conf.d/50-

xserver-command.conf: 

        [SeatDefaults] 

        # Dump core 

        xserver-command=X -core +iglx 

Because of this complexity in the setup, we recommend in general to use TurboVNC 
for remote logins instead of ssh -X.     
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VISUALIZATION ELEMENTS IN THE GUI 

For in-depth analysis of simulation results, images of geometries and images of 

properties can be displayed in 2D cross-section (SEM) view and in 3D rendering.  

Different features are available for visualization in 2D and in 3D. A great number of 

attributes and features may be toggled and adjusted to complement and enhance the 
images’ visual information.  

The activation of these GeoDict visualization features is governed directly through 

four points of access in the Graphical User Interface (GUI): 

A. View menu in the Menu bar 

B. Settings menu in the Menu bar 

C. View Controls above the Visualization area, are greyed out if no structure is 
loaded in memory. 

D. Visualization tab and Color & Visibility tab in the GUI Sidebar, both are 

expandable and may be undocked.  

The GeoDict GUI at the start of the program is partitioned into Menu bar, Toolbar, 
Project Status section, Module section, Visualization area, the expandable tabs 

in the GUI Sidebar, and the Console & Notifications section:  

 

 

Module section 

Project Status section 

Menu bar 

Toolbar 

Visualization area and View Controls 

Console & Notifications 

S
id

e
b
a
r Recent Files and Folders  
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A. VIEW MENU 

When a structure is loaded, choosing between the View menu entries changes the 
visualization settings. A shortcut to many of these parameters can also be set through 

the tabs in the GUI Sidebar, as explained starting in page 18. 

The View menu allows to: 

▪ choose the visualization type to be 2D Cross Section (SEM), or 3D Rendering, 
with 3D Structure Renderer and 3D View Ratio 

▪ display the Visualization area in Full Screen 

▪ select which components are displayed in the visualization area, and 

▪ choose the Legends / Overlays to be displayed.  

 

Some of these options are only accessible when choosing to visualize in 3D 
Rendering or when visualizing solver results (Volume Field, Streamlines, 
Particles, Triangle Mesh, Schlieren, Arrows, and Tensors). 

Selecting Full Screen makes the Visualization area occupy the entire screen. 
Pressing the Esc key on the keyboard returns the program to the normal display, 

containing all the components of the GeoDict GUI layout.  

In 3D Rendering, the structure can be rendered using the graphics card (GPU) or 
the main processor (Box with raycasting or Smooth with raycasting). Volume 

raycasting is an image-based volume rendering technique that computes 2D images 
from 3D volumetric data sets. Examples to these options can be found on page 48. 

When un-checking Structure, the complete structure model disappears from the 
display. 

Among the choices for the visualization of computational results (after running, for 
example, a flow solver computation, a filtration simulation, or generation of a 

http://en.wikipedia.org/wiki/Volume_rendering
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triangulation mesh) are the display of flow Volume Field, Streamlines, Particles, 

Triangle Mesh, Schlieren (Line Integral Convolution), Arrows, and Tensors.  

To start the visualization of computational results, result fields must be loaded by 
selecting File → Load Volume Field… in the menu bar, or directly by clicking Load 

or Load Volume Field in the Result Viewer of a GeoDict result file (*.gdr). 

Among the Legends / Overlays, the checked Bounding Box activates the border 

surrounding the domain in 3D Rendering. Scale Bar or Axes activate the scale bar 
and/or the coordinate stencil in the lower left corner of the display in 2D Cross 
Section (SEM) or in 3D Rendering.  

Unchecking Volume Field Legend and/or Material Legend hides the legends with 
information on the computational results after running calculations or on the 

constituent materials (Material IDs) present in the structure. 

Clicking  in the Legends / Overlays menu, unfolds the 

corresponding settings in the Visualization Settings dialog (Sidebar → Visualization 

tab → Legends / Overlays section). 
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B. SETTINGS MENU 

The Color & Visibility Settings are available from the Settings menu in the menu 
bar,. 

 

Selecting it in the menu bar has the same effect as selecting the Color & Visibility 

tab in the GUI Sidebar on the right side, or clicking the  icon in the toolbar. 

COLOR & VISIBILITY SETTINGS 

In all three cases, the Color & Visibility Settings open as a panel that can be also 
undocked from the GUI by clicking . The Color & Visibility Settings can be 

collapsed either by clicking  in the upper right corner or by re-clicking the Color & 

Visibility tab in the GUI Sidebar. 

The undocked Color & Visibility dialog can be closed with the red  in the upper 

right corner. 
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The default color settings, applied to the background and materials during the 

generation with GeoDict, can be changed through the Color & Visibility Settings 
dialog. While up to 256 material IDs can be present in a structure, only the colors for 
the IDs contained in the current structure can be edited. 

All settings changed in the Color & Visibility Settings dialog are applied directly if 
Apply Immediately is checked. When the checkbox is disabled, the Apply button 

next to it is enabled to apply the changes only when desired. 

 

A color preset is a group of colors that are applied together. 

Click Load Preset and, in the Load Color Preset dialog, select whether to display 
the generated structure’s material using one of the presets.  
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The number of colors shown in the preset previews depends on the number of 

materials present in the current structure. If for example 100 IDs are present, the 
dialog looks as follows: 

 

The user may select new colors through the buttons in the Color & Visibility 

Settings dialog and save the current group of colors as a preset (Save as new 
Preset), to have it appear in the list of color presets later. 
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The preset can be removed anytime by right-clicking on it and selecting Remove 

Selected Item. 

 

 

The visibility of the materials in the structure, for example of Material ID 01, is 

controlled by checking or unchecking  visible. In the example below, material ID 

01 is still present in the structure, but it is just not visible. 

 

 

By default, the Material ID 00 is the background material surrounding the objects, 
inside the domain indicated by the bounding box. In the default settings, the visibility 
of Material ID 00 is un-checked, to be able to see the objects in the structure in 3D 

rendering, and the color is white.  

The color and visibility of Material ID 00 can be changed. In this example, this has 

the effect of showing a block in 3D rendering that corresponds to the domain, in the 
color selected for Material ID 00 (here, orange).  

Default Projector friendly Black & White 
 

Gray values Material Database 
 

Reversed Gray values 
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To change the color selected for a material from the default (e.g., Dark gray) to 
another color (e.g., yellow), click the button for the color (here: dark gray) and select 

the yellow color from the table. 

 

To change the default color to a user-defined color, select the 

three-dots icon. 

 

 

 

In the opening Select Color dialog enter the RGB values that 

define the color and click Add to Custom Colors. Alternatively, 
the rectangle for the new color can be dragged to occupy the 

place of the old one in the custom colors.  

The new color setting is applied to the material after clicking OK.  
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The Background Color of the Visualization area, at the top of the Color & Visibility 

Settings dialog, can be changed in the same way. 

 

The color and the visibility can be changed for all materials at once in the Change all 
line below the Background Color line. As soon another color is selected, the color 

for all material IDs is set to the chosen color. If unchecking (checking) the visible 
checkbox, all material IDs are set to invisible (visible). 

 

The icons at the bottom of the dialog can be used to: 

◼  Save current settings to file: the new color settings can be saved into *.gps 
(GeoDict Project Settings) files (e.g., ColorSettings.gps) and later loaded to be 

reused. 

◼  Load settings from file: saved color settings can be loaded. 

◼  Load built-in default settings: the default colors can be reloaded.  

◼  Load start-up settings: load the color settings that have been set as start-
up settings. 

◼  Set current settings as start-up settings: set the current color settings as 
start-up settings. 

 

Resting the mouse pointer over an icon shows a tooltip explaining the icon’s function. 
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C. VIEW CONTROLS AND VISUALIZATION AREA 

At the program start, the Visualization area shows the GeoDict splash screen. When 
structures or result fields are loaded in GeoDict, they are shown in the Visualization 

area and the View Controls panel appears above it. The displayed image might be 
of a fibrous-, paper-, granular-, sintered-, pleated-, woven-, or grid-structure created 
with one of GeoDict’s structure generators, an image from an opened *.gdt file, an 

image imported and segmented with ImportGeoVol or ImportGeoCAD from a stack of 
3D image data (µCT, FIB/SEM), or other structure models. 

The View Controls panel shows information and options for the visualization of the 
image displayed in the Visualization area. The items shown in the View Controls 
and the image display in the Visualization area are closely related. They are influenced 

and change accordingly with the parameters selected in the View menu and in the 
Visualization tab and the Color & Visibility tab of the GUI Sidebar (see pages 

18ff and 6ff, respectively). 

The View Controls panel is organized into tabs with the controls for structure 
visualization and result fields computed for it (and accessible through the result file).  

 

See below starting in page 21 for information on setting the options in the View 
Controls tabs to optimize the visualization of images from geometry data and 

property data. 

View Controls 
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Collapse the View Controls panel by clicking  in the upper right corner. 

The View Controls panel can be undocked by clicking the corresponding icon  in 

the upper right corner. Close it by clicking  in the upper right corner. 

 

The image in the Visualization area might be a 2D or 3D image of any structure model 
generated with one of GeoDict’s structure generators. The displayed image of a 

structure may originate also from an opened *.gdt file, the GeoDict format, an image 
imported with ImportGeo from a stack of 3D image data (µCT, FIB/SEM), or other 
geometry models. 

The visualization in 2D or 3D changes the View Controls, by activating other tabs to 
access features for the visualization of geometry data or result data. 

 

 

 

 

 

In 2D Cross Section and in 3D 
Rendering, zoom by keeping the 

right button pressed and 
simultaneously moving the mouse 

forward. By moving the mouse 
backward, the image zooms out. 

In 3D Rendering, zooming is also 

possible by scrolling the mouse 
wheel. 

 

 

2D View 

3D Rendering 
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VIEW CONTROLS FOR 2D CROSS SECTION VIEW 

In 2D cross section view, the Visualization area shows a slice of the current image 
of a structure or result field and the positioning of the camera can be set in the View 
Controls, with the controllers of the 2D view, under their tabs.  

 

The 2D image itself is displayed in the center of the Visualization area. Zoom either 

stepwise with the Zoom icons in the Camera tab or smoothly by keeping the right 
mouse button pressed and simultaneously moving the mouse forward. By moving the 

mouse backward, the image zooms out. 

As long the structure is not zoomed out to be smaller than the domain width, it can 
be moved within the visualization area by pressing and holding the left mouse key 

and dragging it around. 

The zoom and the position in the Visualization area can be reset by clicking 

 in the Camera tab.  

Also, in the Visualization area, the Material Legend shows information on the colors 
and materials IDs used for the objects in the structure. GeoDict’s material concept 

and the material database are described in the Material Database handbook. 

As described above in pages 7ff, the colors for the materials can be changed through 

Settings → Visibility & Color Settings, through the icon  in the toolbar, or by 

unfolding the Color & Visibility tab of the GUI Sidebar.  

Status bar 

Visualization 
area 

Material 
legend 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MaterialDatabase&release=2024
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The Material IDs can be changed through Settings → Select Constituent 

Materials… in the menu bar or the  icon in the toolbar.  

At the bottom of the Visualization area, the Status Bar shows information about the 
visible slice and direction. When switched on, a scale bar shows the physical size of 
the visible image.  
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VIEW CONTROLS FOR 3D RENDERING 

After selecting 3D Rendering view, the available settings for the tabs are changed 
in the View Controls and more tabs become available:  

 

In the Visualization area, below the View Controls, the Material Legend shows 

information on the colors and materials IDs used for the objects in the structure.  

With 3D Rendering view selected, the structure image can be rotated by placing 

the cursor on the Visualization area, keeping the left mouse button pressed and 
moving it. Change the focus point for the rotation by double-clicking in the 
visualization area. Then, the structure can be rotated around this point. 

Zoom by keeping the right button pressed and simultaneously moving the mouse 
forward. By moving the mouse backward, the image zooms out. Zooming happens 

also by scrolling with the mouse wheel.  

Pan the structure around by keeping the middle mouse button pressed and 
simultaneously moving the mouse in the desired direction. 

The source of light falling on the structure can be changed by moving the mouse while 
keeping the CTRL key and the left mouse button pressed. 

Also, the light source can be easily changed, by clicking the  icon in the toolbar. 
Then, a beam spot appears in the Visualization area near the structure model. Move 
the mouse with the left mouse button pressed to observe the changing position of the 

light source. The beam spot disappears after clicking the  icon in the toolbar and 

moving the mouse. 
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The camera and light positions can be reset by clicking  in the Camera 

tab. 
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D. VISUALIZATION TAB AND COLOR & VISIBILITY TAB 

The Visualization Settings dialog unfolds when clicking the Visualization tab in 
the Sidebar of GeoDict and it covers and combines most parameters, commands, 

and settings that are located in the menu bar and in the View Controls , and also 
some additional parameters.  

Thus, it allows to set all values for the visualization of structures and results fields 

obtained with GeoDict. Some of these parameters are redundant and also displayed 
in the View menu in the menu bar and the View Controls, but are duplicated in the 

GUI Sidebar. Others only are available the Sidebar. 

Collapse the Visualization Settings again either by clicking  in the upper right 
corner or by clicking the Visualization tab in the sidebar. 

The Visualization Settings can be undocked by clicking the corresponding icon  

in the upper right corner. Close it by clicking  in the upper right corner. 

In the following pages, many instances of the doubling are shown. For example: 

Initially, only visualization settings related the structure currently displayed in the 
Visualization area are shown in the dialog. 

The Visualization Settings dialog expands automatically to the location of 

parameters that directly apply to the visualization settings of what is being displayed 
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in the Visualization area, when clicking the gear wheel icon ( ) in the bottom right 

of the View Controls .  

In the example above, the structure is shown in 2D Cross section view in the 
Visualization area and, when opening the Visualization Settings dialog, the Mode 
is automatically selected as 2D and all parameters concerning the display are listed 

in the panel.  

This feature simplifies changing the values of these parameters, as it is not necessary 

to search for them in the menu bar or in the View Controls .  

Tooltips guide the user through the parameters of the Visualization Settings dialog. 

All settings changed in the Visualization Settings dialog are applied directly if Apply 

Immediately is checked. When the checkbox is disabled, the Apply button becomes 
clickable to apply the changes only when the user decides to do it.  

 

The selection of the Mode to be 2D or 3D affects the choices of settings for these 
two ways of rendering. 

On the bottom of the Visualization Settings dialog, a group of icons controls the 

following in regard to visualization. Resting the mouse pointer over an icon prompts 
a tooltip showing the icon function to appear. For example, through them, it is easy 

to save all the current view settings and reload them: 

  

 Undos the last change in the view settings. 

  

 Redos the last undo. 

  

 Saves the current view settings to a GeoDict Python file (*.py). 

  

 Loads view settings from a GeoPy (*.py) file.   

  

 Resets all view settings to the built-in default settings. 

  

 Resets all view settings to the saved start-up settings. 

  

 Saves the current view settings as start-up settings. 
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Additionally, many view settings can be saved partially as Start-up Settings by 

clicking on the corresponding icon  next to the setting parameter.  

Right-clicking on the labels opens a dialog offering the following options: 

 

◼ Save partial View Status saves all settings corresponding to the selected 
section in a GeoPy macro (*.py) and can be applied whenever needed by 

selecting Macro Execute Macro / Script from the menu bar. To learn more 
about how to record, execute and edit macros refer to the GeoPy scripting 
handbook of the User Guide. 

◼ Record partial View Status records the settings corresponding to the 
selected section to the macro currently recording. When no macro is recorded, 

nothing happens when selecting this option.  

◼ Load built-in default loads the built-in default values only for the selected 
section. 

◼ Load Startup loads previously saved custom start-up settings for the selected 
section. If no custom start-up settings were saved, the built-in default values 

are loaded. 

◼ Use Set current as Startup to set the current settings as start-up settings for 

the selected section.  

 Records the current view settings in the session macro. If a macro is 

recording, the current view settings are also recorded to the macro. 

 
 

 Synchronize the visualization settings of two  GeoDict instances on the same 

Computer to compare structures and volume fields. 

 

 

 Shows all visualization settings. If not selected, only the view settings 
affecting the current visualization are shown. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=Automation&release=2024
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SETTING VISUALIZATION OPTIONS FOR DATA DISPLAY 

When the image of a structure or a result (volume) field is displayed in the 

Visualization area, many preferences and options can be toggled and adjusted in the 
View Controls, under the View menu, and in the Visualization tab in the GUI 

Sidebar to complement and enhance the images’ visual information. The access to 
several of the visualization options is redundant, meaning that they can be controlled 
from these three locations, for the user’s convenience. 

The default display, after starting GeoDict, is 2D Cross Section (SEM) view. The 2D 
view can be obtained at any time by clicking the 2D icon in the toolbar or selecting 

the 2D mode in the Visualization Settings dialog. 

Different tabs appear in the View Controls  depending on the current view mode (2D 
Cross Section SEM or 3D Rendering), as explained above in pages 14ff. These tabs 

are grayed out or selectable depending on the data associated with the image. The 
content in these tabs is reflected in the Visualization Settings dialog (Sidebar → 

Visualization tab → Visualization Settings dialog). 

 

 

 

 

The next graphical examples (below) explain how to set visualization options through 

the tabs in the View Controls and in the trees of the Visualization Settings dialog.  

All parameters under the View menu of the menu bar are integrated in the 
Visualization Settings dialog.  

For this, in this Visualization handbook, the images shown in the Visualization area 
are the geometry data of a fiber structure generated with FiberGeo or the volume 

field from representative result files obtained from thermal conductivity computations 
with ConductoDict, from flow simulations with FlowDict, and from a simulation of 

particle filtration with FilterDict-Media.  

Simulations run on a microstructure with the property predictor modules of GeoDict 
produce result files (.gdr). The results in the files are numerical in nature and can be 

directly analyzed and plotted. For many of the predictor modules, a portion of the 
results are saved into files for visualization in 2D view and 3D rendering as property 

images. For more information on result files, refer to the Result Viewer handbook of 
the User Guide. 

 

2D View 

3D Rendering 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ResultViewer&release=2024
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Setting visualization options for 2D Cross Section view 

GeoDict 2024 User Guide  23 

SETTING VISUALIZATION OPTIONS FOR 2D CROSS SECTION VIEW 

Four tabs are present to control the 2D view settings: Camera, Structure, Volume 
Field, and Arrows.  

The greyed-out Volume Field tab and Arrows tab correspond to the visualization of 
property data from result files and are explained starting on page 30. 

The Structure tab is always selectable and checked by default when a structure is 

loaded. The settings in the Structure tab are explained starting on page 27. 

CAMERA 

Under the Camera tab of the View Controls , the user can choose which part of the 
structure is to be shown in the Visualization area. Here, with the initial default of 
Direction X, the tab is Camera (Y, Z). 

 

Two visualization options are available for the Legend Placement. If Overlay is 

selected, the legends are displayed above the 2D image, while for Attached the 
legends are placed around the image.  

 

Direction X, Y, or Z, selectable though the pull/down menu, are the directions to 
which the cutting plane is perpendicular.  

For example, choosing X-Direction slices the structure along the X-axis and shows 
images in the YZ-plane. The Slice slider controls the display of the cross-section in 

the selected cutting plane. The slice can be changed by moving the slider, by entering 
the slice number, or through the up and down arrows.  
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The Depth slider controls the slice view profundity when visualizing in 2D cross 

section mode. This allows to visualize images very similar to those produced by 
Scanning Electron Microscopy (SEM).  

The maximal Depth value is given (and can be changed) by the Decay value (see 

page 18 for the Visualization Settings dialog: Camera → Camera 2D → Decay)  

The results of changing the depth are most noticeable in black and white view (Color 

& Visibility tab from the sidebar → Load Preset button → Black & White).  

 

Change the image’s Orientation by switching between Bottom to Top and Top to 
Bottom.   

 

By default, the Grid is set Off. Enable the grid by selecting one of the other three 

options: Regular Grid, Adaptive Grid and Structure Outlines. 

If a compressed flow field computed with the LIR solver is loaded, the Adaptive Grid 
is visualized when the user unchecks Decompress fields while loading the volume 

field. (A compressed field is saved when checking Write Compressed Volume 
Fields under the Solver tab of the LIR Solver Options dialog).  

Unchecking Decompress fields to observe the Adaptive Grid has the effect of 
disabling some visualization features. 
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Then, select Adaptive Grid, as the Grid to be shown, under the Camera tab in the 

View Controls . Observe the small grid cells displayed near the pore-solid interface 
and the large grid cells in the center of big pores. Select Structure Outlines to 
display the outlines of the structure.  
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Some additional options and most of the options from the View Controls  are also 

found in the Visualization Settings dialog. Expand the Visualization Settings 
dialog either by clicking the gear wheel icon in the bottom right of the Camera tab 
or by clicking the Visualization tab in the sidebar and unfolding the Camera → 

Camera 2D section.  

 

When panning the structure in the visualization area with the left mouse key, the 
values for Position Horizontal and Position Vertical change accordingly. The 
structure can only be panned, if zoomed in. 

In the Visualization Settings dialog, control the Zoom by entering values directly. 

Change the Background Color for the structure by clicking on the color button. 
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STRUCTURES - GEOMETRY DATA 

A fiber structure generated with the FiberGeo module of GeoDict is used here to 
explain the visualization settings. 

The Structure tab is always selectable (when a structure is loaded) and it is checked 

by default. 

 

By unchecking the Structure tab, the structure disappears from the Visualization 

area because the display is disabled. Only the Material Legend, a white rectangle 
showing the domain, and the Status Bar remain visible. 

The same effect is achieved by unchecking  through the View menu or 

from the Visualization tab of the GUI Sidebar as described below for the 3D view. 

In the Structure tab, Clipping of the values ClipX, ClipY, and ClipZ allows cutting 
the displayed geometry in two of the three spatial directions with the sliders or by 

direct input. The clipping values corresponding to the selected view direction are not 
available, and thus grayed out.  

Additionally, after defining a clipping area with the sliders or direct input, the user can 

limit this as the area of interest by checking Invert in the View Controls. Only the 
area defined by the clipping values remains visible in the Visualization area. 

In the following example, X was selected for Direction in the Camera tab. Thus, the 
clipping is done in Y- and Z-direction.  
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The Structure section in the Visualization Settings dialog allows to set the 

Visibility and the Color of the materials. They may also be defined in the View 
Controls and Color & Visibility panels.  
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Select Use Database Colors to visualize the materials in the colors saved in the 

GeoDict material database. The colors are also automatically changed according to 
the materials, if they are reassigned or a new structure is loaded or generated. For 
materials set to manual, the colors are not changed. To learn more about the database 

and how to set material colors, refer to the Material Database handbook of the User 
Guide.  

 

 

 

  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MaterialDatabase&release=2024
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RESULT FIELDS – PROPERTY DATA FROM SIMULATIONS 

Open a result file (*.gdr) by clicking the  icon in the toolbar and navigating to the 

location where a file, for example, obtained with ConductoDict is saved. Here, the file 
name is EJHeatResult.gdr and the example structure is a fiber structure as shown 
below.  

The Result Viewer of the .gdr result file opens at the Results – Report tab.  

Unless the structure is already in memory and showing in the Visualization area, click 

Load Structure to display it.  

 

Observe the structure in 2D view in the Visualization area by selecting View → 2D 

Cross Section (SEM). 
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In the Result Viewer, click the Data Visualization tab. 

Check the result field to load, here VolumeField_z.hht, and click Load to access the 
computed results in this case the results of temperature flux saved in the *.hht file. 
When loading a result field, additionally the corresponding structure is automatically 

loaded, if not already in memory.  

The directions that were not selected are not computed, and, thus, are unavailable. 

Then, choose the components whose results can be visualized. 

 

If the results are computed for the solid materials, as is the case in this example, the 
user is offered the choice to set the materials in the structure invisible. This is done 

to better observe the result field without the microstructure overlapping it. It is 
recommended to click Yes. 
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Now, the display in the Visualization area changes and the user can observe the 

information computed for the gradation of temperature. The values are indicated on 
the color bar of the Volume Field Legend that appears to the right (default position).  

 

It may be useful to switch off the display of the Material Legend (View → 

Legends / Overlays → Material Legend in the menu bar or in the GUI Sidebar). 
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VISUALIZATION OF VOLUME FIELD 

The parameters that control the visualization of the volume field in 2D are under the 

Volume Field tab of the View Controls  and, with a few more choices, in the GUI 
Sidebar under the Data View  Volume Field tree as well.  

 

Among them is the choice of the component that is rendered in the 2D visualization, 

selected through the Color By pull down menu. 
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Clicking the Edit… button for Color Map… in the Volume Field tab, or Open Color 
Map Dialog in the Visualization Settings dialog, opens the Color Map dialog to 

fine-tune the visualization of results.  

 

For example, if the Data Range is set to Manual, the point handles can be moved 

to quickly designate the upper and lower limits of the Value Range (Low and High 
Threshold) and apply Transparency to the visualized results. As usual, the values 
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entered in the Color Map dialog can be saved into *.gps (GeoDict Project Settings) 

files and/or loaded from them. 

 

A color map is applied to the given data range. The data range can be selected in the 
following ways: 

Manual – allows to enter minimum and maximum values directly. 

Min/Max – the minimum and maximum values from the field are used. 

Extended – the minimum and maximum values are chosen to be an easy-to-read 

number rounded to the extended range. 

Percentiles - minimum and maximum values are computed from the field’s 
histogram. 

The histogram is displayed on the left and can be zoomed in and out with the Zoom 
icons. The view can be reset again with the corresponding icon. If Manual is selected 

for Data Range, the thresholds can also be set with the red squares in the histogram. 
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When zooming in deeply into the histogram, the resolution is not refined 
automatically, as it can take some time. Therefore, then click Refine View.  

For flow simulation results obtained with the FlowDict module (see below), it is 
interesting to “see-through” the flow field and to emphasize the areas where the flow 
is fast.  

Click Transparency in the Color Map dialog, and change the shape of the 
transparency curve by adding and moving new anchor points.  

To add new points either left-click in the plot and click Add Point on the right or 
right-click in the plot and click Add Point there.  

Move the points either by drag and drop or by entering the desired values for Position 

and Opacity for the selected point.  

 

Observe the transparency gradient in the flow field with the following settings: 
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In the Color panel, the user controls the color gradient. Change the complete Color 
Space, by selecting a different option from the pull-down menu. The Resolution can 

be set to Discrete or Continuous. In the color graph points can be added by left- or 
right-click and selecting Add Point. The Point Color and Position can be changed 
on the right, creating a custom color space. 

The Isosurfaces are only visualized in 3D rendering and are explained on page 64. 
The according settings are shown when checking Show Isosurfaces Settings. 

If Apply Immediately at the bottom right of the dialog is checked, these choices are 
instantly used on the display in the Visualization area, while keeping the Color Map 
dialog open to make other changes. Otherwise, click Apply to change the visualization 

settings.  

Click Close when the visualization fits your needs. 

Create different color maps in the current session for the different result fields. To do 
so, in the Color Map dialog enter a Name and click New Color Map in the Color 
Map dialog or, in the View Controls, unfold the pull-down menu for Color Map and 

click Add. 
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Edit the settings as desired, and switch between the current color maps by selecting 

the needed color map from the pull-down menu in the Color Map dialog, in the View 
Controls  or thru the Visualization Settings dialog of the GUI Sidebar.  

 

Having different color maps is very useful, if different result fields should be displayed 

in different color styles. In the Visualization Settings dialog, for each of the result 
fields under Data View, find the option to select a Color Map for the corresponding 

result field; here shown for the Arrows. 

 

The Color Map dialog also offers the possibility to Rename or Remove Color Maps. 

Save all color maps for later use in other GeoDict sessions, in a *.gps file or as start-
up settings with the corresponding buttons in the bottom of the Color Map dialog. 

Resting the mouse pointer over an icon prompts a ToolTip showing the icon’s function. 
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In 2D mode the volume field colors cannot be interpolated. Thus, only None is 

selectable from the pull-down menu for Interpolation. The different interpolation 
options for the 3D mode are described starting on page 65. 

 

In the View Controls  or the Visualization Settings dialog, choose the Material IDs 
in which the volume field is visualized. This helps in better observing a value of a 

computed component of the volume field. To do so, select these materials from the 
Material ID’s pull-down menu.  

By default, all Material IDs present in the structure are selected. 

In the case shown here, the flow only happens in the material occupying the pore 
space (Material ID 00), since the fluid in the structure does not flow through the solids 

(here, Material ID 01). The flow velocity is displayed in the space occupied by Material 
ID 00. The flow velocity is not displayed when the Material ID 00 is disabled.  

 

Points of equal value of the selected local field can be visualized as cross-sections of 
isolines (appearing as black lines) when changing the default selection Lines→ off in 

the Visualization Settings dialog (Data View  Volume Field  Lines). 

Choose the result field component for the lines. It is also possible to visualize for 

example the velocity colors, while visualizing the Pressure lines. This gives the 
possibility to look for correlations. 

Enter the desired Number of Lines and modify the appearance of the lines through 

the value Drop Factor. Smaller values for Drop Factor result in larger line shadows, 
while higher values lead to smaller shadows. 
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To the right side of the Volume Field tab, in the View Controls , checking 

Threshold allows a clipping that is not related to the spatial coordinates but to the 
visualized data range. The areas with values between the respective threshold values 
appear white/transparent This might be used, for example, to visualize only the flow 

velocity values between 0.00006 (6e-05) m/s and the maximum of 0.0002 (2.05e-04) 
m/s. In the Visualization Settings dialog, find the option as Visibility → By Value 

→ Threshold. 
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VISUALIZATION OF ARROWS 

Another flow field visualization option is representing the volume field by an arrow 

field.  

Here, the properties of the fluid flow field are imaged at all positions of a regular grid 
that do not belong to the solid. At each of these positions, the local orientation of the 

flow field is indicated by a vector and its length and color are coded for the fluid 
velocity.  

Small vectors indicate a slow fluid velocity and long vectors indicate a high fluid 
velocity. Vectors are located with their middle in the center of the voxel for which 
they represent the flow velocity. 

To see the arrows, check only View → Arrows in the menu bar, the Arrows tab in 

the View Controls, or Data View  Arrows in the Visualization Settings dialog. 

 

The options are the same as for the 3D visualization described starting on page 79. 
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SETTING VISUALIZATION OPTIONS FOR 3D RENDERING 

A structure appears in the Visualization area after loading a file (*.gdt, *gad). Then, 

select View → 3D Rendering in the menu bar or click  in the toolbar. 

In the View Controls, above the structure displayed in 3D, up to nine tabs are 

selectable to control the 3D view settings: Camera, Structure, Volume Field, 
Streamlines, Particles, Triangles, Schlieren, Arrows and Tensors.  

 

The grayed-out tabs correspond to the visualization of property data from result files 

and are explained starting on page 53. 

Additionally, the Structure tab is always selectable (when a structure is loaded) and 

it is checked by default. The settings in the Structure tab are explained starting on 
page 47. 
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CAMERA  

The Camera tab controls the light behavior, the camera angle from which the 
structure is viewed and the position of the structure in the Visualization area. 

 

The check boxes improve the visual perception of the structure, as follows: 

◼ Checking Show Outlines adds outlines around objects to emphasize the edges in 

the structure.      

◼ Depth Darkening darkens areas according to their distance to the camera, 

resulting in a better depth perception. 

◼ Checking Show Halo shows a subtle halo around objects. 

◼ Global Lighting simulates a realistic light behavior but needs more hardware 

resources. 

◼ Enable Shadows to cast shadows from opaque parts of the structure. 
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In the Visualization area, with 3D Rendering view and  selected in the toolbar, 

rotate the image by keeping the left mouse button pressed and moving it. Zoom by 

keeping the right button pressed and simultaneously moving the mouse forward. By 
moving the mouse backward, the image zooms out. Use the middle mouse button to 
pan and move the structure. 

The function of the left mouse button can be changed, by choosing one of the icons: 

  
  

    

The controls Translation X, Translation Y, and Translation Z determine the 

position of the structure in the Visualization area. By changing these voxel values in 
one axis direction, the structure is translated in this direction by the specified number 
of voxels. When panning the structure with the middle mouse button or using the 

panning icon , the values in the translation parameter boxes change 
simultaneously. 

The controls Rotation HDG, Rotation ATT, and Rotation BNK define the rotation 
of the structure in the Visualization area. To reproduce a specific view of a 3D 

structure, pre-recorded values may be manually entered. The acronyms stand for 
Heading, Altitude, and Banking and correspond to terminology for aircraft control 
simulation. When rotating the structure with the left mouse key the values are 

updated automatically. 

Additionally, using the controls Rotation X, Rotation Y, and Rotation Z the 

structure can be turned around the specified axis. 

Clicking the Reset View button, the 3D image in the View Controls  returns to the 
0.00 position for all translation controls and rotation controls. 

Some additional options and most of the options from the View Controls can also be 
found in the Visualization Settings dialog. Expand the Visualization Settings 

dialog either by clicking the gear wheel icon in the bottom right of the Camera tab or 
by clicking Visualization tab in the sidebar and unfolding the Camera → Camera 

3D section. 

Additional to the Translation parameters also Local Translation can be determined 
for the three directions. The local translation depends on the structure’s rotation, 

since it always takes place in direction of the geometric axes, displayed in the bottom 
left of the visualization area. 

The Light rotation parameters control the position of the light source. The values also 

change automatically when changing the light position as described on page 16.  
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The Field of View defines the viewing arc in degrees.  
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STRUCTURES - GEOMETRY DATA 

A fiber structure generated with the FiberGeo module of GeoDict is used here to 
explain the visualization settings.  

The Structure tab is always selectable (when a structure is loaded) and it is checked 

by default.  

By unchecking the Structure tab, the structure disappears from the Visualization 

area because the display is disabled. Only the Material Legend, the Bounding Box 
showing the domain, and the Axes remain visible. 

The same effect is achieved by unchecking  through the View menu or 

the Visualization Settings dialog. 
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In the Structure tab, it is possible to switch between the three 3D Structure 

Renderers (Box, Smooth, GPU). Alternatively, the user can switch between the 
three Structure Renderers through the View menu (View → 3D Structure 

Renderer, see page 4). Additionally, switching between the three is also accessible 

through the Visualization Settings dialog. 
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GPU RENDERER 

If GPU is selected for Structure Renderer, in the Visualization Settings the GPU 

Renderer section becomes available. Three options can be chosen. 

The structure can be visualized as a Wire Frame. 

Visualize the Back Faces of the structure while the front becomes invisible. 

Checking High Quality increases the quality in trade-off to performance. 

 

TRANSPARENCY – BOX RENDERER AND SMOOTH RENDERER 

While using the Box Renderer, transparency can be applied to the displayed structure 

by selecting Surface or Volume as the Transparency Mode, instead of the default 
None. For the Smooth Renderer, transparency is applied after selecting Volume 
(Surface is not selectable) 

 

For the choices Surface and Volume, clicking the Transparencies’ Edit… button 

opens the Transparency Options dialog. Here, the user can define the transparency 
level for all materials in the structure. 
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In this example, Material ID 00 is set to invisible, but the transparency of Material ID 

01 (solid) can be defined with values between 0 and 1. The smaller the value, the 
more transparency is applied. 

 

Additionally, the transparency options are also accessible through the Visualization 
Settings dialog. 

 

The Transparency for the Smooth renderer is similar as for the Box renderer, but 
there is an essential difference: Transparency can be only applied to a single material 

in the displayed structure.  

After selecting Volume as the Transparency Mode, select the material to which 
transparency is applied (Transparent Material) and the level of transparency. The 

smaller the value, the more transparency is applied.  
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On the right side of the Structure tab and in the GUI Sidebar, Clipping of the 

values ClipX, ClipY, and ClipZ (or X, Y, and Z) allows cutting the displayed geometry 
in all three spatial directions with the sliders or by direct input.  

Additionally, after defining a clipping area with the sliders or direct input, the user can 

limit this as the area of interest by checking Invert in the View Controls or selecting 
Invert Clip Area for Clipping Mode in the Visualization Settings dialog. Only the 

area defined by the clipping values remains in the Visualization area.  
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USE DATABASE COLORS 

Enabling the checkbox Use Database Colors in the Structure section of the 

Visualization Settings dialog sets the colors of the constituent materials according 
to their defined color from the GeoDict material database. If the material is set to 
Manual, the color is not changed. Changing the color afterwards disables the 

checkbox. 

  

The material color can be defined in the Material Database accessible by selecting 

Settings Open & Edit Material Database from the menu bar or by clicking the 

corresponding icon  in the toolbar. 

 

For more detailed information on the material database refer to the GeoDict Material 

Database handbook of the User Guide. 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MaterialDatabase&release=2024
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MaterialDatabase&release=2024
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RESULT FIELDS – PROPERTY DATA FROM SIMULATIONS 

Open a result file (*.gdr) by clicking the  icon in the toolbar and navigating to the 

location where the file was saved. Here, the result file was obtained after running a 
Filter Life Time simulation with FilterDict and the name of the file is the default 
FilterLifeTime.gdr. 

The Result Viewer of the result file opens at the Results – Report tab. Observe the 
results in 3D view by selecting View → 3D Rendering in the Menu bar. 

VISUALIZATION OF PARTICLES 

Click the Particle Visualization tab. Buttons in three panels give access to the 
visualization of particle trajectories, the visualization of the particle positions with 
time, the visualization of the deposited dust with time and the visualization of the 

fluid flow field.  

In the Particles panel, move the slider to select the Batches of particles to be 

visualized. For example, keep the choice to visualize all batches that ran in this 
filtration simulation, which is batches 1 to 11 in the example.  

Trajectories should be checked to observe the movement of the particles. 

Then, click Load Particles.  
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The structure model appears in the Visualization area in 3D Rendering with the 

stationary particles of Batch 1 above the structure (at the inlet domain).  

At the bottom-right of the visualization area, observe the Batch number and the point 
in Time of the filtration process. In case they are not shown there, enable the 

checkbox Show Overlay in the Particles section of the Visualization Settings 
dialog. 

Above the Visualization area, in the View Controls , the parameters for the 
visualization of the particles during the filtration process simulation are selectable 
under the Particles tab. 

Additional parameters can be found in the Visualization Settings dialog as always 
by clicking the gear wheel icon in the bottom right of the View Controls  

 

In the Visualization Settings dialog (Data View  Particles), control the Color 
Scheme by selecting between Moving State, Material, Size, and Batch ID from 

the pull-down menu.  

If Moving State is selected for Color Scheme the default Green color of the non-
filtered particles can be changed with Moving Color. The color of the filtered particles 

can also be changed from the default dark gray with Deposited Color. 

For Material, Size, and Batch ID the colors are selected automatically and depend 

on the selected property. 

Sometimes it is useful to switch off the visualization of the structure by deselecting 
Data View  Structure. 
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In the View Controls , the sliders for Time and Speed Ratio control the visualization 
of particle movement. Moving the slider or directly entering a Time allows displaying 

the particles at a particular point in time.  

 

The Speed Ratio controls the visualization speed by entering values directly or by 
moving the slider. Low values of Speed Ratio result in the particle movement process 

being shown in slow motion, whereas high values lead to faster motion.  

The animation of the particles, in which the particles move through the filter structure, 

starts by clicking Play. The Batch number changes from 1 to the last batch, as the 
batches of particles appear in the inflow region above the filter media model and pass 
through it. The bigger particles are caught and held by the filter material whereas the 

smaller ones pass through to reach the outflow region. 

The Time slider does not return to zero when the animation has finished and must 

be set to the initial value to restart the animation. However, checking Loop makes 
the animation play endlessly. 

Checking Short Time adapts the visualization Time to the period when most of 

particles move. This option cuts off the final part of a simulation where only a few 
particles move at very low velocities and virtually no changes are visible to the 

observer.  

Checking Periodicity activates periodic boundary conditions for the visualization of 
the simulation results. This is only recommended if the simulation was also done with 
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periodic boundary conditions. In the Visualization Settings dialog, select where to 

apply periodicity from the pull-down menu for Periodicity. If for example, XY (Z 
Open) is selected, the periodicity is only applied in X- and Y- direction, while the Z-
direction is open for particle movement.  

Below, two images of batches 1 and 9 are shown. The color of the particles hovering 
over the structure has been changed from the default green to red. The deposited 

particles are shown in dark gray. 

 

Clip the particle visualization area by enabling a clip direction, and moving the 
corresponding sliders or entering clipping values.  

 

Otherwise, in the Visualization Settings dialog, use the option Data View  

Particles  Visibility  Clipping, working the same way as described for the Volume 
Field on page 67.  

If the particles move through different materials, choose the Material IDs where the 
particles should be visible. 
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Custom Visualization of Particles 

The display of the particles moving through the filter media model and their 
trajectories can be customized. 

 

The Particles and Trajectories pull-down menus can be set to: 

◼ None to show no particles (or no trajectories), 

◼ Filtered to show only the filtered particles (or their corresponding trajectories),  

◼ Not Filtered to only show the particles that are not filtered (or their corresponding 
trajectories), 

◼ Time Out to display only particles (or their corresponding trajectories) whose 

movement could not be simulated completely within the time defined for each 
batch. For example, in some cases, a few particles can have very small velocities 

in the inflow region compared to most of particles and therefore their behavior 
cannot be simulated completely within the defined batch time, 

◼ All to show the particles (or their corresponding trajectories) caught in the 

structure and those that went through it, or  

◼ Custom. This option is only available in the Particles pull-down menu, but also 

applies for trajectories. 

When choosing Custom for the visualization of Particles, the Edit Custom… button 
overlays and replaces the standard Trajectories pull-down menu described above. 

Now, the visualization of trajectories is controlled through the Visualization - 
Trajectories option of the Custom Particle Selection dialog.  

Settings for a user-defined, customized visualization can be defined by clicking the 
Edit Custom… button. The Custom Particle Selection dialog opens. 

 

The Custom Particle Selection dialog may remain open to observe the changes that 
the selections have on the visualization of particles moving through the structure. The 

custom particle options can be changed while the particle animation is playing, so 
that the effect of the selection can be observed immediately. 
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Clicking Add Selection adds the current batch of particles to the visualization and 

generates Selection 1.  

 

The selection can be disabled by unchecking the corresponding checkbox or deleted 
by clicking Remove. 

 

Clicking  at the left of Selection 1 opens the options: Previous Batches, 

Diameter Selection, ID Selection, Type ID Selection, Final State, Deposition 

Zone, Multiplicity, and Visualization.  

Parameters for all these options are accessed by clicking on their  symbol.  

To see all previous batches, check Previous Batches. When left unchecked, only the 
particles of the current batch can be seen. 
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Diameter Selection 

Checking Diameter Selection limits the visualized particles to those with a particle 

diameter in the range specified by min and max. This option only has an effect if the 
particles exhibit a particle size distribution.  

 

ID Selection and Type ID Selection 

Every particle has a specific ID and a specific Type ID. Every particle is counted and 
has its own specific ID. Furthermore, every diameter has its Type ID, which means 

that if you have 30 different diameters, there are 30 different Type IDs.  

 

The ID Selection and Type ID Selection work analog to the Diameter Selection, 
merely picking out particles based on their individual particle number and specific 
Type ID rather than their diameter.  

Final State 

Final State enables the visualization of particles that obtained a particular state at 

the end of the simulation.  

 

In the Not Filtered panel, particles that did not get attached to the filter/porous 
medium are selected as follows: 

◼ Out-Flow denotes particles that left the computational domain via the fluid 
outflow region.  
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◼ In-Flow designates particles that left the computational domain via the fluid 

inflow region.  

◼ Time-Out identifies all particles that do not stick to the porous medium and 
did not leave the computational domain via the inflow or outflow, i.e. slow 

particles.  

◼ Hit End Material only shows particles which hit the end material. This only 

applies if the Particle End Position in the simulation is set to material ID and 
not to the outflow plane. 

◼ The Max. Displacement reached state can only be achieved in AddiDict.  

The Filtered panel contains the options for particles that became attached to the 
filter/porous medium: 

◼ Adhesion selects all particles that are attached to the porous media because 
of adhesive forces.  

◼ UDF selects all particles that are filtered by a model from a user defined 
function (UDF). This is only available for FilterDict results. 

◼ First Touch selects particles that stick to the porous media on the first time 

they touch it. 

◼ Sieving selects particles that simply lie on the porous media but do not stick 

to it, like happens in the other two options.  

◼ Pass Through selects particles that are filtered by the pass-through model. 

◼ Adsorbed selects particles that were adsorbed in a porous medium. The 

adsorption model is only available in AddiDict. 

Deposition Zone 

The Deposition Zone defines a location in the computational domain where the 

particles must be situated at the end of the simulation to be eligible for visualization. 
This zone is delimited by the min / max coordinates of the Cartesian direction in which 

fluid flow occurs, i.e., Z-axis.  

 

Multiplicity 

Particles can be selected depending on their multiplicity. Particle Multiplicity is a 
simulation option for unresolved particles which helps reducing simulation time for 

very small particles. For detailed information see the FilterDict handbook of the User 
Guide. 

Visualization 

Checking Visualization allows more adjustments for the visualization of simulation 
results.  

Checking Particles displays all particles that conform to the options previously set in 

the dialog.  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=FilterDict&release=2024
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Checking Trajectories displays the trajectories 

which correspond to the selected particles. With 
this option, it is (for example) possible to show 
only the trajectories which correspond to a certain 

particle type.  

Checking Periodic enables periodic boundaries 

for the particle movements display. Particles which 
leave the domain at one side re-enter at the 
opposite side. 

Green, the default color for the particles, can be 
changed to another color through the button (for 

example,  Dark red). 

The Diameter Factor scales the particles sizes 

relative to their original size for visualization 
purposes and enables the display of particles that 
are nominally below the visibility of the 

visualization settings. The diameter of all particles 
moving in the simulation artificially grows by this 

factor when visualizing them.  

Clicking Add Selection again makes a new 
selection appear (e.g., Selection 2), to combine 

different visualization selection models and is 
useful to observe, for example, particles with two 

different diameter ranges (through Diameter 
Selection).  

As an example, here, we show the settings to 

visualize particles with a diameter from 0 µm to 2 
µm in  Dark red, and particles with a diameter of 

3 µm to 5 µm in  Dark cyan.  

Particles with a diameter bigger than 2 µm and 
smaller than 3 µm are not shown at all.  

Here, only particles with a Deposition Zone 
between 0 µm and 150 µm will be visualized. 
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VISUALIZATION OF VOLUME FIELD 

To visualize the volume field, in the Result Viewer of the result file, under the Particle 

Visualization tab, in the Flow Field panel, click Load Flow Field.  

Note: Visualizing particles simultaneously with the flow field is also possible.  

 

In the Loading volume file FlowField.vap dialog, select the desired components of 

the flow field to be shown. Click OK. 

The structure model and the flow field are shown in the Visualization area in 3D 
Rendering. 

Above the visualization area, in the View Controls , the parameters for the 
visualization of the flow field are selectable under the Volume Field tab. If needed, 

the visualization of the structure can be switched off by unchecking the Structure 
tab box. 
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The data of a particular flow field component 

can be chosen for display from the Color By 
pull-down menu (here it is Velocity).  

 

 

Clicking Edit for Color Map opens a dialog to fine-tune the visualization of results. 

The settings in the Color Map dialog were explained above in pages 34ff. 

 

For example, in the Color Map dialog, the 

user can use the set Percentile High and 
Percentile Low clipping values and then, 

check Transparency and move the points in 
the transparency curve as follows: 
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In 3D rendering now also the Isosurfaces in the Color Map dialog can be displayed, 

if Transparency is checked. Enable Show Isosurfaces Settings and emphasize 
selected values in the volume field, by changing their transparency. Note, that 
disabling the checkbox does only hide the isosurfaces settings in the Color Map dialog 

and not the isosurfaces in the visualization area. 

Click Add Isosurface to add a point in the graph. Move the point as desired or enter 

a Position. Set the Transparency and the color for the selected isosurface.  

 

 

 

 

 

In the example, the Structure tab in the View 

Controls  is disabled and the transparency 
settings are as shown above. An isosurface 

was added for a velocity of 0.005 m/s and the 
transparency was set to 0.8. As Automatic 
Color is checked, the color of the value is not 

changed, but due to the higher transparency 
value, the green isosurface is emphasized. 

 

 

 

 

Transparency can also be enabled or disabled 

from the View Controls or the Visualization 
Settings dialog. In the Visualization Settings 
dialog, also the overall transparency Density can 

be changed.  

 

The settings for the display of flow field 
isosurface Lines through the Visualization 
Settings dialog (from the Sidebar) are 

explained above in pages 39ff, and are only 
visualized, if transparency is disabled. 
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For most volume fields, by default, the colors of the 

volume field are not interpolated and just the raw 
voxel values are shown. In the View Controls  and 
in the Visualization Settings dialog, several 

options are available for Interpolation.  

 

 

 

Select Linear to interpolate the colors linearly 

between surrounding voxel centers.  

 

 

 

Indexed Color is only available for integer fields, as for example *.g32 files. For 

integer fields, usually this is the default setting. If selected, the different index values 
have distinguishable colors. 

 

Choose Interpolation on Visible to interpolate 
the colors linearly between surrounding voxels, 
while not interpolating into invisible areas. Thus, 

color fringes are removed. In the example on the 
right, material ID 01 is selected as invisible. Thus, 

the flow field is not visualized in the glass fibers.  
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Interpolation On Visible (Smooth) works similar to 

interpolation On Visible, but generates a smooth 
surface.  

 

 

 

 

 

 

Select Per Material to linearly interpolate only 
within the materials to preserve sharp edges. 

 

 

The Threshold By pull-down menu in the center 
panel of the View Controls and, the Volume 
Field  Visibility  By Value option in the 

Visualization Settings dialog, allows a clipping 
that is not related to the spatial coordinates but 

to the data range.  

 

 

The Threshold By menu has the same options as Color (here VelocityX, VelocityY, 

VelocityZ, Velocity, and Pressure). For example, only flow velocities above 0.004 (4 
10-03) m/s or then above 0.008 (8 10-03) m/s are visualized.  
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By default, the threshold Mode (or By Value  Mode) displays velocities greater 

than or equal to the clipping value, but the user may choose, from the pull-down 
menu, to display only velocity values smaller than or equal to the clipping value or 

only values that are equal to the clipping value.  

 

Unchecking Smooth voxelizes the surface of the volume field. 

From the pull-down menu Visible on Material IDs select in which material IDs the 

volume field is visualized. If for example, a flow field is loaded, no flow happens in 
the solid materials, and thus they can be unchecked. 

 

The displayed data can be spatially clipped in all three directions (ClipX, ClipY, ClipZ) 
with the sliders or by direct input. This facilitates the simultaneous visualization of 

e.g. structure model and flow field.  

 

 

The GPU section, in the Visualization Settings dialog, offers additional visualization 
options using the graphics card instead of the main processor, when checking 

Enabled. The data needs to fit in the GPU memory to use this feature. 
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Control the amount of Ambient light, Diffuse scattered light and Specular mirror-

like highlights, while determining the size of highlights with Shininess. These 
parameters correspond the Phong Reflection Model, often used in 3D computer 

graphics. The light intensity controlled by them is independent of the light direction. 
Higher values for Shininess result in smaller highlights. 

Alpha By Grad sets a focus to the edge regions. For high values only the edges are 

visible.  

Alpha By Angle determines the visibility for the current camera angle. Higher values 

result in a more transparent volume field. 

 

https://en.wikipedia.org/wiki/Phong_reflection_model
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The shading is controlled by the Min Grad (minimal gradient magnitude). Higher 
values reduce clutter due to noisy data. 

The parameters Outline Threshold and Outline Strength apply outlines to the 
volume field with the given threshold and strength. 

 

With the last parameter determine the overall Density of the volume field. 
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VISUALIZATION OF STREAMLINES, ARROWS, AND SCHLIEREN 

As part of the visualization of the flow field, several GeoDict modules, e.g. FilterDict 

or FlowDict, can also display the streamlines left by the fluid when flowing through 
the structure, an arrow field for the flow, and the schlieren produced when the fluid 
flows through the structure (see Schlieren imaging for more info).  

For these three visualization options, the complete vector field needs to be loaded. 
From the Result Viewer load the result field from the Vizualization tab, here Particle 

Visualization. For a FilterDict result click Load Flow Field and select VelocityX, 
VelocityY, VelocityZ, and Velocity as components of the flow field to be loaded.  

 

The initial default visualization after loading can be optimized by modifying the 

parameters under the Streamlines, the Arrows, or the Schlieren tabs in the View 
Controls, above the Visualization area. 

Check these tabs to make their options selectable. At the same time, to only visualize 
the selected fields, turn off the visualization of the flow field by unchecking the 

Volume Field tab. If needed, also switch off the display of the structure model 
(Structure), as indicated in page 47.  

This can also be done through the View menu as follows: 

http://en.wikipedia.org/wiki/Schlieren_imaging
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Or through the Visualization Settings dialog, as follows: 

 

As soon as the Arrows, the Streamlines, or Schlieren are checked, they are loaded 
into the Visualization area, and the parameters needed to set their visualization can 
be modified. 

For beautiful visualizations, also more fields can be 
visualized at once, for example by clipping them in 

parts, as described on page 67, or if the volume field 
is turned on, enable Transparency in the Volume 
Field tab and adjust the transparency settings in the 

Color Map dialog, as described starting on page 34. 
In the image on the right, the structure is clipped 

halfway in X-direction, the volume field is set to 
transparent, and the streamlines are enabled.  
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Visualization of Streamlines 

To see the streamlines, check only View → Streamlines in the menu bar, the 

Streamlines tab in the View Controls, or Data View  Streamlines in the 
Visualization Settings dialog. 

 

 

The Flow pull-down menu shows Velocity as the only choice.  

The color coding of the streamlines is based on the fluid flow results for VelocityX, 
VelocityY, VelocityZ, and Velocity.  

Checking Periodic enables periodic boundaries for the display of the streamlines, i.e. 

the streamlines exiting the tangential domain boundaries are reentering the domain 
periodically. 
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The choices in Line Style are Streamlines, Streamlets, and Streamtubes. The 
thickness for each line style is controlled through Line Thickness. 

     

Choosing Streamlets activates the visualization of the streamlines as streamlets, a 
visualization in which a streamline is fragmented into segments.  

The movement of these segments along the streamline is visualized and can be 

animated by clicking Play. The animation is repeated in an infinite loop until Play is 
clicked again. 

 

The visualization and animation of streamlets is controlled by four options in the 
Visualization Settings dialog:  

◼ Number of Streamlets defines the number of segments that represent a 

streamline. The larger the number, the easier it becomes to identify the complete 
streamlines. 

◼ The streamlet Length determines the fraction of each streamline that is displayed. 
In combination with the number of Streamlets per Streamline, it defines the length 
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of the streamlets. The larger the number, the lower the distance between the 

streamlets. For a length of 1, the streamlets connect to complete streamlines.  

◼ The Number of Frames controls the speed of the animation by specifying the 
number of frames that are to be visualized when clicking Play. Small numbers 

produce fast and short animations. Large numbers produce slow animations, with 
more frames. 

◼ The Current Frame is updated automatically, when stopping the animation. While 
no animation is played, any frame between 0 and the entered Number of Frames 
can be visualized. 

 

The setting Scale to Velocity also affects the visualization of streamlines and 

streamlets and is coupled with Minimal Velocity. This is a clipping tool based on the 
velocity of the fluid. In this case, streamlines and streamlets with a velocity lower 

than the specified Minimal Velocity are not shown in the visualization.  
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When Streamlets is chosen, Scale to Velocity additionally adjusts the movement 

of the streamlets in relation to the maximum velocity of the flow field. As a result, the 
streamlets move with individual velocities and not with a uniform speed, as they would 
do without a scaled velocity.  

In the Visualization Settings dialog the option is found under Data View  

Streamlines  Visibility. 

 

The choices for Placement define from where the streamlines, streamlets, or 

streamtubes are calculated. 

 

Select the streamline starting positions from the pull-down menu for Placement (or 

Placement  Type). Either the starting points (or seeds) for the calculation are 
placed at the Inflow-Plane, in a grid in the 3D-domain (3D-Box), randomly 
distributed in the entire domain (Random), in one of the materials (Material ID), 

inside of a circle (Circular), along a line (Line), or at a given point for a single 
streamline (Point). 

Choosing any of them gives options for their display, as seen here on the left for the 
Inflow-Plane Placement. 
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Selecting Inflow-Plane distributes the starting positions on the flow field inflow 

plane. In flow fields, this plane is determined by the flow direction. If for example, 
the flow is computed in Z-direction, the inflow plane is the XY-plane. Then, Count 1 
and Count 2 define a grid in the inflow plane. Increasing the number, increases the 

number of streamlines in the respective direction.  

 

Selecting 3D-Box for Placement Type defines a three-dimensional box with corners 
(Start 0, Start 1, Start 2) and (End 0, End 1, End 2). Inside this box Count X x 

Count Y x Count Z streamlines are placed regularly. 

 

To distribute the starting positions randomly, select Random. For Random 
Placement choose a value for Count, controlling the number of starting positions for 

the streamlines. 
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Choosing Material ID places seeding positions only inside voxels of the selected 

material ID. Max Count defines the number of starting positions for streamlines. The 
seeding points are all placed at voxel center positions. If there are less voxels of the 
material ID present, than given for Max Count, less streamlines are visualized. 

 

Select Circular to place the streamline starting positions on circles around the defined 
Midpoint. The Direction then defines an axis through the Midpoint on which the 

circles are placed. Define the Radius for all these circles. The number of circles is 
controlled with the value entered for Repeat. The distance between the streamline 

starting positions on the circles is defined by Density. 

 

The placement type Line places the starting positions on a line from (Start 0, Start 
1, Start 2) to (End 0, End 1, End 2). The value for Count controls the number of 

streamline starting positions. 
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Select the placement type Point to place a single streamline at the starting position 

defined by Position 0, Position 1, and Position 2. 

 

The placement only defines the starting positions. If a streamline starts in, or quickly 
runs into a solid structure voxel, the streamline has a length of 0 and is invisible. 

When there is flow through the entire domain, entering on one side, leaving on the 

opposite side, the Inflow-Plane option is preferable. For a flow, which starts 
somewhere in the domain, such as Lithium-flow in a battery simulation, either 3D-

Box or Random are appropriate.  

The streamlines, streamlets, and streamtubes cannot only be clipped according to 
their velocity but also conforming to their spatial position, in a similar way as 

explained above for the display of the Volume Field (page 67).  

It is possible to define the range of voxels in each spatial direction that are to be 

displayed by moving the slider or by direct input of the value. 
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Visualization of Arrows 

Another flow field visualization option is representing the volume field by an arrow 
field.  

Here, the properties of the fluid flow field are imaged at all positions of a regular grid 

that do not belong to the solid. At each of these positions, the local orientation of the 
flow field is indicated by a vector and its length and color are coded for the fluid 

velocity.  

Small vectors indicate a slow fluid velocity and long vectors indicate a high fluid 
velocity. Vectors are located with their middle in the center of the voxel for which 

they represent the flow velocity. 

To see the arrows, check only View →  

Arrows in the menu bar, the Arrows tab in the View Controls, or Data View  

Arrows in the Visualization Settings dialog. 
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The Colors pull-down menu applies these properties to the vectors resulting from the 

simulation. Colors are determined by the velocity of the flow at the corresponding 
position. Colors can be assigned all previously chosen components, whereas the 
Direction Field is fixed to Velocity.  

Visible on Material IDs defines the material IDs in which the arrow field is shown. 
This allows to visualize the flow also in porous media where fluid flow is computed 

according to the Stokes-Brinkman equations (porous voxels / solid voxels / pores). 
Several material IDs can be selected at the same time.  

The Arrow Scale scales the size of the arrows as a percentage of the maximum 

dimension (here, velocity).  

If Colors is turned off, a custom Color can be applied to all arrows by clicking on the 

color button.  

 

Minimal Length sets the minimum length used for the slowest arrow, before scaling. 
The values are limited to those between the maximum and the minimum in the Plot 
Range (here, between 0.00 and 0.012 m/s).  

Count X, Count Y, and Count Z define the number of arrows for each axis. 

 

 

Clipping works in the same way as seen in page 67 for the clipping of the flow field 

and streamlines.  

Distance To Structure defines a space around the solid structure model that is to 
remain void of arrows. If enabled, Distance To Structure Range 0 and Distance 

To Structure Range 1 give the range of distance where the vectors are shown (in 
voxels). 
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Checking Normalize visualizes all arrows in the same size.  

 

Mode changes the display of the arrows to appear as a Line or Thick. 

 

 



Visualization in GeoDict 2024 

82  GeoDict 2024 User Guide 

Visualization of Schlieren - Line Integral Convolution (LIC) 

Schlieren is the third option to visualize the fluid flow field provided in FlowDict, 
AddiDict and FilterDict. LICs are visually displayed as distorted striations or streaks in 
2D sections that represent fluid motion through the 3D flow field, in any of the three 

directions. Schlieren are only available in 3D Rendering. 

To observe the schlieren, check only View → Schlieren in the menu bar, the 

Schlieren tab in the View Controls, or Data View  Schlieren in the Visualization 

Settings dialog. 
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For Flow, only Velocity is available, as the Schlieren are computed from this flow 

field. 

Direction defines the location of the schlieren 2D section in the three directions. For 
example, to examine the schlieren along the Z-direction, change the Position value 

as indicated: 

 

Clipping works in the same way as seen in page 67 for the flow field, streamlines, 
and arrows.  

Checking Normalize activates the normalization of the visualization in relation to the 

maximum fluid velocity.  

 

 

Resolution specifies the number of pixels in one spatial direction that represent the 
related voxel.  
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Type allows predefined post-processing of the schlieren by choosing from the pull-

down menu. Type 0 displays the original LIC and Type 1 to Type 4 each applies a 
different sharpening filter to the original LIC.  

 

Length defines the elongation of the individual LIC lines.  

 

Colorize defines whether the schlieren are displayed in gray scales or in color. The 
color then can be selected from the flow fields, available in the pull-down menu for 

Color Field.  
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TENSORS 

To visualize the Tensors, a result field 

containing tensors must be loaded. Here, a 
Flexural Test was simulated on a fiber 
structure with ElastoDict.  

 

 

 

In the Result Viewer of the result file, under 
the Strain/Stress Visualization tab, in 

the Flow Field panel, select a Time Step 
and click Load.  

 

 

 

 

 

 

 

 

 

 

In the Loading volume file 
StrainStressResult.das dialog, the 

complete vector field needs to be loaded. 
Either all Strain components and / or all 
Stress components. Click OK. 

The structure model and the volume field 
are shown in the Visualization area in 3D 

Rendering. 
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To see the tensors, check only View → Tensors in the menu bar, the Tensors tab 

in the View Controls, or Data View  Tensors in the Visualization Settings 
dialog. 

 

Select, if the Tensor Field should be displayed for Strain or Stress. 

The Glyph Type can be set to Box, Ellipsoid, Main Direction or Super Quadric.  

 

The Coloring can either be set to Main Direction or Shape. 
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For Main Direction, the main eigenvector is interpreted as RGB, i.e. red, green and 

blue. An eigenvector for strain or stress is the direction (x,y,z) of the largest principal 
strain the largest principal stress, respectively. If the vector is pointing in X-direction, 
the color is red, if it is pointing in Y-direction, the color is green and for the Z-direction 

it is blue. For everything in between, the colors are interpolated. 

 

For Shape, the color depicts the shape of the tensor, i.e. the color depends on 

whether the tensor is mainly linear, planar, or spherical. If the shape is mostly linear, 
the color is red, if it is mostly planar, the color is green, and if it is mostly spherical, 

the color is blue. The figure below (see also [1]) shows how the certainties (𝑐) for the 

tensor shape are computed based on the non-negative eigenvalues 𝜆1 ≥  𝜆2 ≥ 𝜆3 of the 

tensor. For strain and stress, the three eigenvalues are the three principal strains or 

stresses. 

 

 

Linear - red 𝑐𝑙 =
𝜆1 − 𝜆2

𝜆1 + 𝜆2 + 𝜆3
 

 

Planar -green 𝑐𝑝 =
2(𝜆2 − 𝜆3)

𝜆1 + 𝜆2 + 𝜆3
 

 

Spherical - blue 𝑐𝑠 =
3𝜆3

𝜆1 + 𝜆2 + 𝜆3
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From the pull-down menu Visible on Material IDs select in which material IDs the 

volume field is visualized.  

 

Clip the particle visualization area by selecting a Clip Direction, enabling Clip and 
moving the corresponding sliders or entering clipping values.  

 

Otherwise, in the Visualization Settings dialog, use the option Data View  

Particles  Visibility  Clipping, working the same way as described for the Volume 
Field on page 67.  

Control the Spacing between the tensors in the three directions. Smaller spacing 
leads to smaller tensors, while larger values for spacing results in larger tensors. 

  

TRIANGLES 

For structures with surface meshes in stl format, e.g. a cylindrical pleat generated 
with PleatGeo or structures imported with ImportGeo-CAD the Triangles tab 

becomes available. 

These options are described in the ImportGeo-CAD handbook of the User Guide. 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ImportGeoCAD&release=2024
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LEGENDS AND OVERLAYS 

If a structure or a volume field are loaded to GeoDict, the settings of all legends and 
overlays in the Visualization area can be changed. For this, open the Visualization 

Settings dialog by clicking the Visualization tab in the GUI Sidebar and unfold the 
section Legends / Overlays.  

Unchecking the box for a legend or overlay option disables the corresponding legend 

or overlay.  

Different options are available for 2D Mode and 3D Mode. 

Tooltips guide the user through the parameters of the Legends / Overlays section. 
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LEGENDS AND OVERLAYS FOR 2D MODE 

Decide, if the Legend Placement should 
be Overlay or Attached. This option is 
also available in the Camera tab of the 

View Controls  and is described on page 
23.  

Change the Font Size for all legends by 
entering the desired value. Also, the Font 
Color Mode can be changed from the 

default Automatic to Manual. If set to 
Manual, a custom Font Color can be 

chosen. The automatic mode only affects 
the material legend and the volume field 
legend. The status bar contents stay 

white. 

Change the Background Color of the 

Visualization area, if needed. 

Decide whether the Status Bar should be 

Shown and select the Status Bar 
Placement to be at the Bottom or Top 
of the visualization area. 

For all legends and overlays unfolding the 
corresponding sections gives access to 

more changeable settings. 

 

 

 

 

 

 

 

 

 

 

 

 

Volume Field Legend 

Scale Bar Status Information Custom Text Axes 

Logo 

Volume Field 
legend 

Status Bar 

Material 
legend 
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MATERIAL LEGEND 

The Material Legend shows which materials are contained in the loaded structure. 

 

Control the legend’s Placement with the parameters Align and Align Sign. Align 

controls, if the legend is placed at the Left, Right, Top or Bottom area of the 
visualization area and Align Sign controls where exactly in this area the legend is 
placed. 

 

VOLUME FIELD LEGEND 

The following explains the functionality of the Volume Field Legend parameters. 

Control the size of the legend by changing the value for Stretch. Enter values 

between 0 and 1. This parameter depends on the total GeoDict GUI size. Thus, a 
Stretch of 1 would be the as wide or high (depending on the legend placement) as 
the GeoDict window. If the Stretch is chosen too high for the visualization area, the 

legend is not displayed anymore. Thus, it is recommended to choose values between 
0.2 and 0.6.  

The value in Decimals determines the number of digits shown after the decimal point.  

Number Format controls the numbers’ display in the legend. Choose between 
Number, Scientific, and Engineering.  

Top 

Neutral 

Right 

Neutral 

Left  

Neutral 

Top 

Negative 

Top 

Positive 

Left  

Negative 

Left  

Positive 

Bottom 

Positive 

Right 

Positive 

Right 

Negative 
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The choice of Plot Ranges controls how to display the spread of the data in the result 

legend. Decide to display Both, only the Plot or the Data range, None of the two 
ranges, or set it to Auto (Automatic), which shows both ranges. 
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The Tickmark Mode controls whether the selection of the number of tick marks in 

the legend should be Manual or Automatic. If set to Manual enter a desired 
Number of Tickmarks. As the tickmark numbers must be “nice numbers”, the 
tickmark number then is set to a number near the entered value, still resulting in nice 

numbers. 

The Placement works as described on page 91 for the Material Legend. 

AXES AND LOGO 

The Placement of these overlays works as described on page 91 for the Material 
Legend.  

 

STATUS INFORMATION 

Decide which Status Information should be shown. The Placement for this legend 
works as described on page 91 for the Material Legend. 

 

SCALE BAR 

Select the Mode to be Percentage or Fixed 

Size. 

If Percentage is selected, enter a Relative Size 
or change the value with the slider. This value 

then determines the size proportional to the 
length of the structure.  
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If Fixed Size is selected, enter a Fixed Size and choose a Unit.  

 

Enable Simple to display the scale bar with simple lines. 

 

Select Show Border to display the rectangle around the scale bar. 

Unchecking Background turns the black background of the scale bar invisible.  

Also, the Font Color can be changed as desired. 

The Placement for this legend works as described on page 91 for the Material 
Legend. 

CUSTOM TEXT 

Enter a custom Text to be shown in the visualization area.  

The Placement for this overlay works as described on page 91 for the Material 
Legend.  

 

METROLOGY 

For Metrology, select the Line Thickness and the Line Color.  

Refer to the GUI, Menu, and Toolbar Reference handbook of the User Guide for more 
details about the Metrology feature. 

  

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=BasicVolume&release=2024
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LEGENDS AND OVERLAYS FOR 3D MODE 

Change the Font Size for all legends by entering a value. Also, the Font Color Mode 
can be changed from the default Automatic to Manual. If set to Manual, a custom 
Font Color can be chosen.  

For Material Legend and Axes only select if they are shown or not and change the 
font size and font color as desired. 

 

Material Legend 

Volume Field Legend 

Axes 

Bounding Box 

Logo 

Scale Bar 

Custom Text 
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For all other legends and overlays, unfolding the corresponding sections gives access 

to more changeable settings. 

VOLUME FIELD LEGEND 

For the Volume Field Legend options refer to the 2D options on page 91.  

Only the legend placement differs, as for the 3D mode, only the Align menu is 

available with the options Left, Right, Top, and Bottom. The volume field legend 
will always be placed in the center of the selected area. 

 

While it is displayed vertically for Left and Right, it is displayed horizontally for Top 

and Bottom. 

When selecting a position interfering with the Material Legend, the material legend 
is moved to another position automatically. 

SCALE BAR 

In 3D mode, the Scale Bar can be placed on the structure according to the three 
Axes (X, Y and Z). Minus then places the scale bar on the origin side of the specified 

axis and Plus on the opposite side.  

Then, rotate the scale bar as desired, by changing the Orientation.  

The scale bar can be Aligned in the Bottom Left, Bottom Right, Top Left or Top 

Right of the specified structure side. 

 

In the following example, the scale bar position is set to default, i.e. the Plus side of 
the Z-axis at the Bottom Left, with a 0 Degree Rotation. 
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Other positions may be better if the structure is rotated differently. In the following 

figure, the Minus side of the Y-axis is turned to the front. Thus, selecting YMinus for 
Axes lets appear the scale bar in the front again. But without changing the 

Orientation, it is displayed upside down in the upper right corner of the YMinus side. 

 

Changing the Orientation to 180 Degree Rotation turns the scalebar about 180 
degrees. Additionally, selecting Top Right moves the scale bar to the top right from 
the structures perspective, in this case resulting in a bottom left position from the 

viewer’s perspective. 
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Setting the Axes to Auto always places the legend on the front of the structure in 

the correct orientation. 

The other available options for Scale Bar are described for the 2D mode on page 93.  

BOUNDING BOX 

If Bounding Box is enabled, the structure’s domain border indicators are displayed.  

Change Thickness and Color as desired. 

 

 

LOGO 

The GeoDict Logo can be Aligned in the Bottom Left, Bottom Right, Top Left or 

Top Right corners of the visualization area. 

 

CUSTOM TEXT 

The Custom Text parameters are the same as for the 2D mode.  
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